Introduction
This document describes a tuning procedure of a clock frequency for RF transceiver.

Target Device
RA4W1 Group

Note: The contents of this document are provided as a reference and do not guarantee the signal quality in the system. When designing the actual system, thoroughly evaluate the product in the overall system and apply these contents on your own responsibility.

Contents
1. Overview .................................................................................................................................... 3
   1.1 Related documents ......................................................................................................................... 3
2. Bluetooth dedicated clock oscillator .......................................................................................... 3
3. Frequency tuning procedure ...................................................................................................... 5
   3.1 Required software ................................................................................................................................. 5
   3.2 Measurement setup ................................................................................................................................. 5
   3.2.1 Observing ANT output frequency via cable connection ................................................................. 5
   3.2.2 Observing ANT output frequency via wireless signal ............................................................................ 6
   3.3 How to use “CLVALTune.exe” ................................................................................................................. 7
   3.4 Tuning procedure of Bluetooth dedicated clock frequency ............................................................. 8
4. Crystal resonator for the RF transceiver .................................................................................... 9
5. Reference ................................................................................................................................ 10
   5.1 Example of frequency tuning ................................................................................................................. 10
6. Appendix Tuning procedure of Bluetooth dedicated clock frequency without UART ........... 12

Revision History .............................................................................................................................. 18
1. **Overview**

This document describes a tuning procedure of Bluetooth dedicated clock frequency.

1.1 **Related documents**

The following documents are related to this application note. Also refer to these documents when using this application note.

[1] Host Controller Interface Firmware (R01AN5429).


2. **Bluetooth dedicated clock oscillator**

Figure 2-1 shows circuit of Bluetooth dedicated clock oscillator. RA4W1 has two load capacitors (CL) internally for the tuning Bluetooth dedicated clock frequency. The internal capacitors are connected to terminals XTAL1_RF and XTAL2_RF respectively. The capacitance of CL can be adjusted in a range of 2-15 pF typically. The oscillation frequency error can be minimized with the appropriate capacitor setting (CLVAL).

The capacitance of PCB pattern between the crystal oscillator and RA4W1 or the parasitic capacitance of the pads for solder mount (Cp1, Cp2) will be factors of oscillation frequency variation. The optimum capacitor setting will be vary depending on the PCB layout as well as the adopted crystal oscillator.

![Figure 2-1. Circuit of Bluetooth dedicated clock oscillator.](image-url)
As shown in Figure 2-2, the obtained “CLVAL” should use as “Bluetooth dedicated clock” configuration in “Bluetooth Abstraction Driver on rm_ble_abs” of RA configurator.
3. Frequency tuning procedure

This section describes a tuning procedure of Bluetooth dedicated clock frequency.

3.1 Required software

Required software for Bluetooth dedicated clock frequency tuning is following.

- UART-HCI mode firmware
  Download a “Host Controller Interface Firmware” (R01AN5429 [1]) from Renesas website. Build and program the firmware to RA4W1 which can be executed in a measurement environment.

- CLVALTune.exe
  This software is included in this document (/bin/ CLVALTune.exe).

3.2 Measurement setup

3.2.1 Observing ANT output frequency via cable connection

In the setup of Figure 3-1, 2440 MHz unmodulated signal is output from ANT port, and the signal frequency is measured by spectrum analyzer via coaxial cable connection. The spectrum analyzer is set to the frequency count mode.

- Required equipment
  - RA4W1 evaluation board (PCB)
  - Spectrum analyzer with frequency counter function (over 3GHz)
  - Coaxial cable
  - PC for evaluation
  - USB to UART cable

![Figure 3-1. Measurement setup of ANT frequency (cable connection)](image-url)
3.2.2 Observing ANT output frequency via wireless signal

In the setup of Figure 3-2, 2440 MHz unmodulated signal is output from ANT port, and the signal frequency is measured by spectrum analyzer via wireless interface. When this measurement setup is selected, measure the frequency in a noiseless environment without immunity from other 2.4GHz band signal. And keep ANT port of RA4W1 and RF input port of spectrum analyzer as close as possible in order to obtain an enough input amplitude at the RF input port.

If the frequency measurement is unstable, solder a coaxial cable to signal line pattern of ANT directly and connect the coaxial cable to the spectrum analyzer like section 3.2.1.

- Required equipment
  - RA4W1 evaluation board (PCB)
  - Spectrum analyzer with frequency counter function (over 3GHz)
  - Antenna for Bluetooth
  - PC for evaluation
  - USB to UART cable

![Figure 3-2. Measurement setup of ANT frequency (wireless connection)](image-url)
3.3 How to use “CLVALTune.exe”

This section describes how to use “CLVALTune.exe”. When using “CLVALTune.exe”, UART-HCI mode firmware which can be executed in the measurement environment is necessary.

Note: When a UART port doesn’t exist in the measurement environment, “CLVALTune.exe” is not available. In this case, refer to Chapter 6.

Figure 3-3 shows “CLVALTune.exe” setting. The setting is common for the cable and wireless connection.

- **COM port**: Depends on PC configuration
- **Baudrate**: Depends on UART-HCI mode firmware (default: 115200 bps)
- **CLVAL**: Capacitor setting for frequency tuning, select an arbitrary value from 0 to 15 (default: 5)
- **CLKOUT_RF**: Select “No output”
- **Continuous Wave Tx**: Select “19ch (2440 MHz)”

![Figure 3-3. Program setting for frequency measurement on ANT port](image-url)
3.4 Tuning procedure of Bluetooth dedicated clock frequency

A tuning procedure of Bluetooth dedicated clock frequency to determine an optimum capacitor setting (CLVAL) is as follows:

1. Run “CLVALTune.exe” with setting shown in Figure 3-4.
2. Select an arbitrary “CLVAL” setting.
3. Click “Start” button. And then unmodulated signal will output from ANT port.
4. Record the frequency count value on the spectrum analyzer display. Then click “Stop” button. The unmodulated signal from ANT port will stop.
5. When the measured frequency is lower than target frequency (2440 MHz) on ANT port, change value of “CLVAL” to smaller. When the measured frequency is higher than target frequency (2440 MHz), change value of “CLVAL” to larger.
6. Repeat steps from 3 to 5 until the difference between measurement frequency and target frequency (2440 MHz) is minimized and determine an optimal “CLVAL” setting.

When determined “CLVAL” setting value by above procedure, the “CLVAL” should use as “Bluetooth dedicated clock” configuration in “Bluetooth Abstraction Driver on rm_ble_abs” of RA configurator.

![Figure 3-4. Example of a description to configuration parameter](image-url)
4. Crystal resonator for the RF transceiver

Carefully consider and determine your crystal resonator in consultation with a crystal resonator manufacturer because the oscillation characteristics depend on several factors. This section shows the notification when selecting the crystal resonator.

- A crystal resonator should be selected to meet requirements of your application regulations
  - For example, in the case of the Bluetooth 5.0 standard, the transceiver clock frequency tolerance which includes an initial error, a temperature drift, and an ageing effect should be less than or equal to +/- 50 ppm.

- Recommended electrical characteristics of a crystal resonator are followings:
  - Equivalent series resistance (ESR) \( \leq 100 \) ohm
  - Drive level \( \leq 100 \) uW
  - Load capacitance \( \geq 5 \) pF, \( \leq 8 \) pF
  - Frequency tolerance \( \leq +/- 30 \) ppm

- ESR should not be greater than the recommended parameter. Using a crystal resonator with higher ESR decreases a negative resistance of the oscillator and may be cause of unexpected start-up failure or longer start-up times.

- Selecting a crystal resonator with a small frequency fluctuation against changes in load capacitance, it helps to improve margins for frequency accuracy requirements of your applications. The amount of frequency fluctuation for the load capacitance is different for each crystal oscillator. Please refer to a datasheet of crystal manufacturers and/or contact them for details.

- A performance of crystal oscillator depends on a board design. Please refer to the board design guideline [2].

- Table 4-1 shows candidates of the 32 MHz crystal resonator for the RF transceiver.

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Parts number</th>
<th>Size code in mm</th>
<th>Tolerance (^1) (ppm)</th>
<th>MAX ESR (^2) (Ohm)</th>
<th>Load Capacitance (pF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDK</td>
<td>NX1612SA-32.000MHZ-CSP-CIS-3</td>
<td>1612</td>
<td>+/- 30</td>
<td>100</td>
<td>6</td>
</tr>
<tr>
<td>NDK</td>
<td>NX1210AB-32.000MHZ-CSP-CIX-3</td>
<td>1210</td>
<td>+/- 30</td>
<td>100</td>
<td>6</td>
</tr>
<tr>
<td>Kyocera</td>
<td>CX1612DB32000A0WPNC1</td>
<td>1612</td>
<td>+/- 25</td>
<td>100</td>
<td>5</td>
</tr>
<tr>
<td>Kyocera</td>
<td>CX1210SB32000BG0JPC1</td>
<td>1210</td>
<td>+/- 30</td>
<td>80</td>
<td>6</td>
</tr>
<tr>
<td>Murata</td>
<td>XRCMD32M000FZQ52R0</td>
<td>1612</td>
<td>+/- 30</td>
<td>60</td>
<td>6</td>
</tr>
<tr>
<td>Murata</td>
<td>XRCTD32M000N1P00R0</td>
<td>1210</td>
<td>+/- 30</td>
<td>120</td>
<td>6</td>
</tr>
</tbody>
</table>

Notes: 1. Where “Tolerance” is a total of “Frequency Tolerance” and “Frequency Stability”.
2. MAX ESR: Maximum Equivalent Series Resistance.
5. Reference

5.1 Example of frequency tuning

This section shows example of frequency tuning. Measurement environment is shown in Table 5-1.

Table 5-1. Environment of frequency tuning

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DUT</td>
<td>RA4W1 56pin QFN</td>
</tr>
<tr>
<td>Crystal oscillator</td>
<td>NX1612SA-32.000MHZ-CHP-CIS-3 (NDK)</td>
</tr>
<tr>
<td>Measuring instrument</td>
<td>E4440A PSA spectrum analyzer (Keysight)</td>
</tr>
<tr>
<td>Monitor port</td>
<td>ANT with cable connection</td>
</tr>
</tbody>
</table>

The frequency error plot changing the CLVAL setting is shown in Figure 5-1. The graph shows when CLVAL is 7, the frequency error is minimal.

![Figure 5-1. Frequency error vs. CLVAL setting](image-url)
Figure 5-2 is a sample of frequency count display when CLVAL is set to CLVAL\textsubscript{opt}. The frequency count value is 2439.9993MHz and the initial frequency tuning error is \((2439.9993 - 2440)/2440 = -0.3\) ppm.

![Figure 5-2. E4440A frequency count display](image-url)
6. Appendix Tuning procedure of Bluetooth dedicated clock frequency without UART

This chapter describes tuning procedure of Bluetooth dedicated clock frequency without UART. In this case, it is necessary to repeat choosing one “CLVAL” from 16 “CLVAL” by using “FrequencyTuningEmbedded.zip” which include this document. The actual procedure is as follows:

1. Make frequency measurement environment according to section 3.2
2. Put “FreqeuncyTuningEmbedded.zip” into any folder
3. Launch e²studio (Figure 6-1)

![Figure 6-1. Launch e²studio](image)

4. Click [file] → [Import] and then following dialog will appear (Figure 6-2)

![Figure 6-2. Import dialog](image)
5. Select [General] → [Existing Project into workspace] and then following dialog will appear (Figure 6-3)

![Figure 6-3. Select import wizard](image)

6. Click [Next] and then following dialog will appear (Figure 6-4)

![Figure 6-4. Import project dialog](image)
7. Click [Select archive file] and select “FrequencyTuningEmbedded.zip” which put in step 1 (Figure 6-5)

![Figure 6-5. Import project from archive file](image)
8. Click [Finish] and then project for frequency tuning will load into e2studio (Figure 6-6)

![Figure 6-6. e2studio after import project](image)

9. Click [Project] → [RA configurator] and then following dialog will appear (Figure 6-7)

![Figure 6-7. RA configurator after import project](image)
10. Select [Stacks] Tab and then following dialog will appear (Figure 6-8)

![Figure 6-8. Stacks Tab of RA configurator](image)

11. Click “BLE Abstraction Driver on rm_ble_abs” and select “Properties” Tab (Figure 6-9)

If there are not “Properties” Tab, Click [Window] → [Show View] → [Properties]

![Figure 6-9. Properties of “rm_ble_abs”](image)
12. Choose an “Bluetooth dedicated clock” value between 1 and 16 (Figure 6-10)

13. Click “Generate Project Contents” and then related code will automatically generate.


15. Record the frequency count value on the spectrum analyzer display.

16. When the measured frequency is lower than target frequency (2440 MHz) on ANT port, change value of “Bluetooth dedicated clock” to smaller. When the measured frequency is higher than target frequency (2440 MHz), change value of “Bluetooth dedicated clock” to larger.

17. Repeat steps from 12 to 16 until the difference between measurement frequency and target frequency (2440 MHz) is minimized and determine an optimal “Bluetooth dedicated clock” setting.
Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>May.07.20</td>
<td>—</td>
<td>—</td>
<td>First edition issued</td>
</tr>
</tbody>
</table>
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
   A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
   The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.

3. Input of signal during power-off state
   Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
   Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
   After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
   Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.).

7. Prohibition of access to reserved addresses
   Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
   Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.
2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.
4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or any third parties arising from such alteration, modification, copying or reverse engineering.
5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.
   - "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.
6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
8. Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.
(Note2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Contact information
For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

Trademarks
Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2020 Renesas Electronics Corporation. All rights reserved.